August 29, 2012  Jasper Schootstra

Title : Step-by-Step Three-Dimensional Modeling and Visualization of an area in the southwestern part of France (in the French Subalpine Basin).

Author : Jasper Schootstra  (student# 4034740)

Date : 29 August 2012
Professor(s) : Drs. J.C. Blom
Supervisor(s) : Drs. J.C. Blom
               Dr. G. Bertotti
               Dr. N.J. Hardebol
TA Report number : AES/BTA/TG/12-12

Postal Address : Section for Applied Geology
                Department of Applied Earth Sciences
                Delft University of Technology
                P.O. Box 5028
                The Netherlands
Telephone : (31) 15 2781328 (secretary)
Telefax : (31) 15 2781189

Copyright ©2012 Section for Applied Geology

All rights reserved.
No parts of this publication may be reproduced,
Stored in retrieval system, or transmitted,
In any form or by any means, electronic,
Mechanical, photocopying, recording, or otherwise,
Without the prior written permission of the
Section for Applied Geology
Abstract


Detailed mapping and 3D structural modeling of the area around St. Nazaire le Desert, in the French Subalpine Basin, which structures had not been modeled previously, was performed in order to understand its structural evolution. The completed 1:25,000 scale mapping of the 52km² area, reveals various structural domains based on regional structural elements. The dominant structures of the area are a thrust fault, stretching from the south to the north, which developed along the weak rocks of the Marnes Bleues formation and the Montange d’Angèle, which is the highest peak in the area.

The model is built on the present-day structure of the basin and comprises 8 horizons within the Upper Jurassic to Middle Cretaceous rocks. The modeling consisted out of different parts:
- Constructing multiple geological cross sections, which were checked for consistency and physical viability.
- Creating a three dimensional model out of the sections and other field data such as maps.
- Restoring and balancing of the three dimensional model, in order to determine its geological and physical viability.

These steps resulted in a potential model for the area of interest, which ensures geological and physical viability. The restoration showed that the area had a 37,3% bigger area before deformation.

As a final point it can be concluded that all structures originate from the collision of the Iberian Peninsula with the southern part of France, and the subsequent collision of the Apulian with Eurasian plates. Both dominant directions, respectively North-South and West-East, can be perceived.
## Index

1. **Introduction**  
   - page: 5

2. **Geological History**  
   - 2.1 Tectonics  
   - 2.2 Regional structures  
   - 2.3 Formations + Stratigraphy  
   - 2.4 Deposition conditions  
   - page: 6

3. **Data**  
   - 3.1 Location  
   - 3.2 Fact map  
   - 3.3 Geological map  
   - 3.4 Geological cross sections  
   - 3.5 Geological structures  
   - page: 10

4. **Structural modeling with Move©**  
   - 4.1 Structural balancing  
   - 4.2 What is structural balancing?  
   - 4.3 Basics of Move©  
   - 4.4 Procedure  
   - page: 14

5. **Two-Dimensional Modeling**  
   - 5.1 Step-by-step balancing  
   - 5.2 Results  
   - 5.3 Discussion  
   - page: 16

6. **Three-Dimensional Modeling**  
   - 6.1 Background information  
   - 6.2 Step-by-step 3D Modeling  
   - 6.3 Results  
   - 6.4 Discussion  
   - page: 30

7. **Conclusions**  
   - page: 38

**Afterword**  
   - page: 40

**References**  
   - page: 40

**Appendix; Original cross sections, maps, etc...**
1. Introduction

Geological structures are three dimensional, but they are typically represented by and interpreted from two dimensional geologic maps and cross sections. These resources are often enough to describe relatively simple structures. With more complex structures, a 2-dimensional maps and cross sections may not be enough to fully understand and assess their complex nature. In these cases, an 3-dimensional model is essential. This research project is aimed at building a balanced 3D model of a complex structure. The data used in this research, were gathered during a geological fieldwork. This fieldwork was part of the curriculum of the study Applied Earth Sciences of the Delft University of Technology, course: TA3942.

During the project, multiple cross sections were created. These were checked for correctness first, in order to start validating the 3D model. The model was restored and balanced using the Move software-package, provided by Midland Valley. Only by balancing a 3D model, the geology could be fully assessed. The resulting structurally valid 3D model, created from the 2D data, provides a basis for ongoing basin modeling and structural analysis. 3D balancing is a key step in constraining and understanding the area of interest.

This report contains eight chapters. In chapter two the geological history of the area will be discussed, including the historic tectonic and regional regime. A stratigraphic chart will also be given in this chapter. Chapter three will look at the data which was available, whereas in chapter four some information about the Move-software will be given. In the fifth and sixth chapter the 2- and 3-dimensional modeling will be introduced and discussed. The conclusion of this project will be presented in the seventh chapter.
2. Geological History

In this chapter, the geological background of the area of interest is discussed. This background will contain a greater tectonic picture of the setting of the area, regional structures related to this setting, and the types of deposition conditions. Finally an outline of the formations and illustration of the stratigraphy will be given.

2.1 Tectonics

The geological history, affecting the area of interest, started in the Permian and is still ongoing. The deposition of the sediments took place from the Late Jurassic, 161 Ma ago, until Early Cretaceous, about 99 Ma ago. During the Permian, 300 Ma ago, almost all the Earth’s land mass was concentrated into a single supercontinent, called Pangea. Due to extension of this supercontinent during the Permian and Triassic an ocean was formed between Gondwana en Cimmeria. This ocean, the Tethys Ocean, can be divided into the Western Tethys and the Eastern Tethys. The Western Tethys, also called Alpine Tethys, is important for the studied area. This was a large shallow ocean that stretched from the present day south east of France over Central Europa to the Aral Sea in western Asia. (LeMoine, 1986).

The region along the northwestern margin of the Western Tethys is traditionally called the “Dauphinois Basin” for the major portion of the Jurassic era. The deeper part of the Dauphinois Basin is called the “Vocontian Trough/Basin”. (Wilpshaar et al., 1996). In general the basin is called “French Subalpine Basin”. This basin was developed when the continents of Africa and Europe started to rift away from each other, creating an extensional basin. In middle Jurassic times, the French Subalpine Basin was a transitional area between the epi-continental sea of the Paris Basin and the deeper Piedmont domain, where a mid-oceanic ridge, in the Piedmont-Liguria-basin, was active until the Early Cretaceous. The basin probably attained its maximum depth (~500 - 800 m) in the Early Cretaceous, due to a general regime of extensional tectonics (Mattioli et al., 2008). During this time, hundreds of meters of limestone-marl alternations were deposited, over a period of 60 Ma.

After this phase, uplift started to occur during the Pyrenees orogeny and West-European rifting. This is contemporaneous with the first phase of Alpine tectonics. The Alpine orogeny can be divided into two phases for the fieldwork area. During the first phase, Late Cretaceous — Miocene, the Iberian Peninsula rotated in an anti-clockwise direction, and collided with the current southwestern part of France, the ‘Eurasian’ plate. This collision caused an N-to-S south compression in the south of France. The Pyrenees were created during this event (Coward & Dietrich, 1989).
The second phase involved the formation of structures with a general W-to-E trend, caused by the collision of Italy, the Apulian plate, with Europe, the Eurasian plate. This phase is still active, the Apulian and European plates are still converging.

From the different directions of the faults, thrusts, folds and other geological structures, the strain-directions mentioned above are easily derived (Gratier et al., 1989).

2.2 Regional structures
The French Subalpine Basin or Vocontian Basin was bounded by the crystalline basement of the Massif Central to the West, by the Provençal Platform to the South and it was open to the East towards the Tethys Ocean. The Vocontian basin was one of the smaller extensional basins in this region. When the Tethys opened up, it caused an extensional regime in the basin; horst and graben structures were formed (Le- moine et al, 1986). However, this extensional stage was not uniform, repeated rifts lasted for up to 40Ma.

The opening of the southern Atlantic Ocean resulted in the end of this extensional phase. Due differential tectonic movements (Joseph et al., 1989) within the French Subalpine Basin, its rift-phase died out. Because of this, the Vocontian basin became part of a passive margin-system. Within this system, regional subsidence took over (Fries & Parize, 2003). With the rotation of the Iberian plate, and the subsequent collision with the Eurasian plate, a system of largely NE-SW oriented compressional faults were formed within the sedimentary basin (Porthault, 1978).

In the late Cretaceous, after the Iberian collision, the first continental collision took place as the northern part of the Apulian subplate collided with Europe. A complex system of faults and thrusts were created. This event caused reactivation of the extensional faults within the Vocontian basin into strike-slip and reverse faults. (Frisch et al., 2000)
2.3 Formations + Stratigraphy

Every stage mentioned in chapter 2.3, has its own characteristic formation. This paragraph provides an overview of the different formations which have been found in the area of interest.

8 formations can be distinguished, over a thickness of ~1375 meters. The oldest rock deposited during the Oxfordian, whereas the youngest rock has been deposited during the Albian.

Between the formations, there is a great variation in thickness, content & color. The illustration below shows a schematic representation of the various formations as they have been found.

---

Legend

Sandstone
Marl
Limestone

---

- Sandstone-limestone / marl : 2/98
- Very soft marl

- Limestone / marl : 90/10
- Very hard limestone
- Dunham: mud- / grainstone

- Limestone / marl : 50/50
- Extremely regular
- Bioturbation, ammonites
- Dunham: wackestone

- Limestone / marl : 20/80
- Very soft limestone
- Bioturbation, ammonites
- Dunham: mudstone

- Limestone / marl : 70/30
- Greyish color fresh limestone
- Very hard limestone
- Dunham: mudstone

- Limestone / marl : 99/1
- Very hard limestone
- Pebbly mudstone
- Dunham: mud- / packstone

- Limestone / marl : 80/20
- Dunham: mudstone

- Limestone / marl : 40/60
- Dunham: mudstone

---
2.4 Deposition conditions
During the Late Jurassic subsidence occurred in the area. Extensive marine sequences indicate a time when much of the European continent, including the fieldwork area, was submerged under shallow tropical seas, with fluctuating sea levels. This caused a major deposition of marl and limestone during the Oxfordian. Pelagic depositions are typical for this period (Gaillard et al., 1987).

The next period, the Kimmeridgian, is characterized as a turbulent one. Turbidites and irregular banks of limestone were deposited. Another remarkable observation is the limestone on limestone banks. During the Tithonian the peak of this turbulent period was reached. This is clearly demonstrated by the three facies of depositions in this period, namely debris-, mud- and grain flows. These flows are originated from the carbonate shelf. The route of these flows along the continental slope was determined by the different fault structures present on this slope. These structures were caused by the period of extension prior to this (Joseph et al., 1987). These depositions vary in thickness.

In the Berriasian, the area was still dealing with the aftermath of the previous turbulent conditions from the Tithonian. This can be noticed from the irregular depositions. Bouma sequences can be found, and a packstone limestone bank has been observed amongst the mudstone banks. During the Early Cretaceous, at the time of the Valanginian, both subsidence and uplift occurred (Roure et al., 1994). First of all uniform subsidence occurred, this was followed up by a transition from extension to compression, which relates to the transition from subsidence to uplift. Finally, only uplift took place. This sequence of events has influence on the kind of deposition.

In the Valanginian and Haurterivian pelagic sedimentation returns, this is clearly demonstrated by the Valanginian, however, is a period of global environmental change, which resulted in a change of the palaeoenvironmental conditions. It caused a crisis in the carbonate production (Gréselle & Pittet, 2010). This effect in combination with a relatively high sea-level, ensured that a large amount of marl was deposited with respect to limestone. The difference between the Valanginian and Haurterivian is the level of the relative sea-level (Cotillon, 1984). During the Haurterivian, the sea-level was lower, therefore thicker limestone banks were deposited.

The period which postdates the Haurterivian, is the Barremian. Looking carefully at the depositions, it is observed that the material is coarser. Given this information it can be concluded that debris flows and slumps transported the material from the shelf to the deeper parts of the basin. The limestone banks which were formed during this period vary therefore in thickness. The limestone banks are coming from the continental shelf (Ferry et al., 1979).

![Figure 4. Pelagic sediments from the Haurterivian period.](image4)

After the seven stages mentioned in this subchapter, in which only marl and limestone were deposited, the Barremian was followed up by a period with a low sea-level; sand was deposited for the first time. The sand originates from the main land, where the source, probably granite, found its way to the surface. Due to erosion and transportation of the eroded material, it finally ended up in the basin. This created layers of sand, which can be found amongst the large quantities of marl. An occasional limestone deposit can be found as well. During these stages, the Aptian and Albian, the basin was cut off from the open ocean (Bréhéret et al., 2000). Periods of flooding caused an anoxic oceanic environment. For this reason, the rocks in these stages contain a lot of organic material (Wilpsaar et al. 1997). The Albian, which is the youngest subdivision of the Early Cretaceous epoch, is the last stage which could be observed in the area of interest.
3. Data

This chapter will present the data available prior to the fieldwork. Furthermore the data which has been obtained during the fieldwork will be presented and discussed.

3.1 Location

The area of interest is situated in the Drôme, a department in southeastern France. Drôme lies within the region of the Rhône-Alpes.

The UTM coordinates of the area are in zone 31T: E = 675867 - 681080 & N = 4937982 - 4927965. The total area of the fieldwork is 52.2 km².

The fieldwork area has a mountainous character, with scarce flat areas in the valleys. These relative flat areas consist of soft marly material and are often used for agricultural purposes. Some parts of the terrain are covered by so-called badlands; these consist of very soft marly material. Characteristic vegetation which grows on these badlands are grass-like plants and broom.

In general it can be concluded that the steeper the slope, the higher the percentage of limestone in the material, the less the vegetation. The badlands are also mostly vegetation-free. The slopes which are formed by middle hard rocks, alternations between limestone and marl are mostly covered by forests.

Characteristic topographic structures/objects which can be found in the area are the Montagne d’Angèle, an E-W running mountain ridge, with an elevation of ~1600 meters, which forms the south-eastern boundary of the fieldwork area. Northwest of the Montagne d’Angèle, a roughly N-S running mountain ridge can be found; the Montagne the Couspeau. The elevation of this ridge varies between 1000 – 1380 meters.
3.2 Fact map
During the fieldwork 106 outcrops have been logged and described. This meant that most of the characteristic features were noted, such as the age of the rocks, their geologic orientations and the notable structures. In figure 9, the fact map, all locations can be found, whereas in figure 10 the map has been laid down over the digital elevation model. These figures provide a good picture of how concentrated the data points, outcrops, are. Especially the northwestern and the southeastern part of the area were hard to access.

3.3 Geological map
This map shows the geological features of the area. The accompanying table shows which color is connected to which stage + formation. This map has been created by means of analyzing aerial photographs, (which were available), the fact map and the topographic map of the area.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aptian &amp; Alban</td>
<td>Orange</td>
</tr>
<tr>
<td>Barremian</td>
<td>Yellow</td>
</tr>
<tr>
<td>Hauterivian</td>
<td>Green</td>
</tr>
<tr>
<td>Valangan</td>
<td>Blue</td>
</tr>
<tr>
<td>Berriasian</td>
<td>Black</td>
</tr>
<tr>
<td>Tithonian</td>
<td>Red</td>
</tr>
<tr>
<td>Kimmeridjan</td>
<td>Gray</td>
</tr>
<tr>
<td>Oxfordian</td>
<td>Brown</td>
</tr>
</tbody>
</table>

▲◄ Top (figure 9): Fact map of the fieldwork area, 106 outcrops have been described. Left (figure 10): DEM, combined with the fact map of the area.

▼◄◄ Most left (figure 11): Geological map which has been constructed. Left (figure 12): Table with information about the different stages + formations and its different colors. Bottom (figure 13): DEM combined with the geological map of the area.
3.4 Geological cross sections
Cross sections serve to clarify the subsurface structure. They show the form and orientation of geological structures. However the geologic cross sections are interpretative, this means that one has to take certain distortions into account. Distortions such as:

- Relative scaling of the horizontal and vertical axes. It is useful to check the ratio between the horizontal vs. the vertical axis. In this project both have a scale of 1:25,000.
- And the way in which the section cuts the actual structure. This effect can cause apparent dips, and apparent thickness of the layers.

During the fieldwork; 5 cross sections were created. But this is not nearly enough to create a viable 3-dimensional model. That's why 4 more section have been created, which makes a total of 9.

Most of the profiles didn't match with each other, therefore they have been adjusted. These changes and modifications which have been applied to the cross sections will be discussed in chapter 5.

Some parts of the area have undergone heavy folding, and corresponding formations contain therefore sharp bends. This makes you wonder what happened to other underlying formations. Below the Pontaix formation, a very weak and soft formation is present, the so-called ‘Terres Noires’. This formation is relatively thick, no outcrops have been found in the area of interest. However it has been observed in adjacent fieldwork areas.

The Terres Noires acts as a kind of lubricator over which the overlying layers/formations were able to move. Most likely, the faults join each other deep below the surface.

Figures 15 & 16 show 2 of the 9 cross sections. The original cross sections can be found in the appendix.

A total of 9 geological cross sections were constructed from the data which was acquired during the fieldwork. Figure 14 shows the locations of the cross sections. 8 formations were drawn in these cross sections. However, for the balancing process only 6 horizons were digitized; top Barremian, top Hauterivian, top Valanginian, top Berriasian, top Tithonian & the top of the Kimmeridgian, since the top of the Aptian/Albian and the bottom of the Oxfordian were not known. All originally drawn sections can be found in the appendix.
3.5 Geological Structures
During the fieldwork 5 main structures were observed in the area of interest. Since these structures didn’t have any names, local topographic names were given to them (figure 17):
- The Couspeau thrust fault
- The Nazaire-Gumiane dome
- The Angèle-Grande Delmas strike slip
- Bouvières thrust fault
- The Montagne d’Angèle
When combining these structures with the other data and with the information from chapter 2, two phases of compression could be interpreted. These interpretations are based on the information prior to the two-dimensional- and three-dimensional modeling.

3.5.1 Phase A: ‘North-South’ compression
The first deformation phase was caused by the first phase of the Alpine orogeny. As mentioned in chapter 2, the Iberian Peninsula rotated in an anti-clockwise direction, and collided with the current southwestern part of France, resulting in a North-South compression in the area of interest. This compression probably resulted in folding of the area. It is assumed that two anticlines were created, one in the northeastern part, and one in the southeastern part of the area. The southeastern fold, the current Montagne d’Angèle, moved subsequently in a northerly direction. It is assumed that the next event was the forming of a strike slip fault from north to south throughout the whole area, the Angèle-Grande Delmas strike slip. In the northern part of the map, this fault coincides with the Couspeau thrust fault. This fault divided the Montagne d’Angèle in two parts; the current Montagne d’Angèle structure and the Bouvières thrust fault. This made it possible that the western part of the Montagne d’Angèle could move further in a northwestern direction.

3.5.2 Phase B: ‘East-West’ compression
In the next phase, the second phase of the Alpine orogeny, Italy collided with Eurasian plate. This collision caused a somewhat East-West compression and is a still ongoing process. During this phase folding occurred again, in the northeastern part of the map, this time with a North-South strike. Due to this perpendicular folding with respect to the first phase, the Nazaire-Gumiane dome was created. This was followed by the occurrence of some minor faults which allowed thrust- and reverse faults. The sequence of these movements is unknown. Inside the Nazaire-Gumiane dome, the formations came under pressure, which resulted in a fault. West of this, the formations were pushed over one another over a long distance, resulting in the Couspeau thrust fault.

Furthermore it is assumed that in the southwestern part of the area the previously discussed western part of the Montagne d’Angèle started to slide over the eastern part.

As mentioned above, especially the southern part of the map has a challenging structure. In the following chapters we will attempt to check the structures for viability, by using two- and three-dimensional modeling.
4. Structural modeling with Move©

This chapter will explain the term balancing, and why it is important in geologic exploration. Furthermore it will give some general information about the software which has been used, Move©, to perform this project, and will present the general procedure to successfully create 3D geological models. 3D models help us visualise the ground beneath our feet without the need for training in complex geological techniques.

4.1 Structural balancing

One of the most important of the structural geologic techniques is structural balancing. The ultimate goals of balancing are to restore complexly deformed rock to its initial state or to its correct palinspastic restoration and to determine the geologic sequence of events. This information can be extremely useful for geologists, geophysicists and other geological explorers. Multiple aspects can be derived from this data, such as: better understanding of the geometry of the structure, accurately locating geologic trends, relation of faults with the structure etc…

4.2 What is structural balancing?

Deformation is assumed to neither create nor destroy rock volume; thus, reassembling the undeformed state from the deformed state is possible. This process is achieved by applying certain geometric rules.

Both 2D cross sections as well as 3D models can be balanced. Balanced 2D cross sections can be restored so that the beds are placed/moved back into their depositional, pre-deformational position (Fossen, 2010). Balanced cross sections link the deformed and undeformed states. A balanced cross section is a section which can be restored without the occurrence of things which are hard to explain, such as variable line-lengths, thickness variations, holes, etc… When a section has been balanced, finite strain analysis can be performed, which can be used as a predictive tool for fracture distribution and orientation. Furthermore, a balanced structural model validates the geophysical interpretation and promotes a better understanding of the geological history of the area of interest. There is not necessarily a unique solution; however a balanced cross section validates the interpretation by being a viable solution.

When the 2D cross sections are clear, a 3D structural model is made of geological interfaces such as horizons, x-sections and faults, with the available observation data. These surfaces should fit the data within an acceptable range, depending on the resolution.

The main rule when balancing is that it assumes that there is a general conservation of rock volume during deformation, and any changes in volume can be quantitatively assessed.

Finally, balancing also tends to keep the interpreter more focused. If the section does not balance, then perhaps it is time to reconsider the interpretation.

4.3 Basics of Move©

Midland Valley’s Move software is developed to model the geometries related to deformation. It can restore cross sections and 3D models by being able to perform the following procedures (Move©, 2012):

- Remove fault displacements.
- Remove the effects of erosion.
- Remove fault related folds with different options; simple shear, flexural slip, fault parallel flow or fault bend fold.
- Remove the volume loss attributed to sediment compaction.
- Remove folding related to flexural slip

These procedures can be applied with the help of various workflows, built into the software.

The techniques used in both 2D and 3D structural restorations can be categorized into two groups:

- Unfolding restorations: Where the fault geometries are ignored.
- Move on fault restorations: where the effects of fault geometry on hangingwall deformation are considered.

In the following chapters both the 2D modeling as the 3D modeling are worked out for the area of interest.

▲ Figure 18. Restoration process; moving the parts of a layer back to their initial position.

² Showing the previous location of geological features, correcting for any intervening crustal movements.
4.4 Procedure

In order to create a viable model different steps have to be undertaken. In the following figures (19-22) represent this steps in a nutshell. In chapter 6, Three-Dimensional Modeling, the procedure will be described in a more precise way.

All steps which have to be done before we can perform 3D balancing in a nutshell;

Step 1: Creating the Digital Elevation Model, DEM, for the area of interest. This will be explained in chapter 6.

Step 2: Inserting the cross sections, which have been checked and corrected or inaccuracies. This step will be clarified in chapter 6.

Step 3: Digitizing the cross sections. This will be explained in chapter 5.

Step 4: Start by creating the layers of the different formations and the faults present in the model. Chapter 6 as well.

After step 4 a 3D model of the area of interest has been obtained. In order to validate the 3D model, the model will be restored and balanced using the Move software-package in chapter 6. Only by balancing a 3D model, the geologic structure can be fully assessed. The resulting structurally valid 3D model, created from the 2D data, provides a basis for ongoing basin modeling and structural analysis. 3D balancing is a key step in constraining and understanding area of interest.
5. Two-Dimensional Modeling

In order to perform 2-dimensional structural balancing, 2D Move is used. 2D Move can answer a variety of earth modeling questions. It is specifically designed to restore and balance geological/seismic sections. This chapter will show the steps together with the results of the balancing process.

5.1 Step-by-step balancing

First, all the hand-drawn cross sections have to be digitized. Once digitized, certain structural modeling techniques can be applied, in which they are checked for physical viability. The workflow for digitalizing and balancing the sections is described below, in a step-by-step guidance.

1. First of all some basic steps need to be performed:
   - Draw a geologic cross section. Keep in mind that the horizontal scale needs to equal the vertical scale and vice versa, since 3D Move Kinematic Modeling uses this as well. After the drawing has been done, the section can be scanned in.
   - Straighten, crop and modify the cross section, keep only the relevant information, i.e. the actual drawn part, figure 23 describes what this means. This modification can be done using a standard image-editing program.
   - Find the UTM-coordinates of the cross section, and measure the height and depth.
   - Open 2D Move.

2. The second step is to open the cross section which will be analyzed:
   - File ➔ Open Image…
   - Select the image, which has been modified, and click on ‘Open’.
   - In the Image Loading screen; select ‘World’.
   - Fill in the UTM-coordinates, the top and the base of the cross section, by doing this 2D Move can scale the section to its right dimensions. (When you save your cross section, and insert it 3D Move, the program knows where to place it, this will be used in chapter 6)
   - By clicking on ‘Apply’, the cross section will be loaded.

▲ Figure 23. Editing cross section with Adobe Photoshop. Keeping all relevant information as indicated in the figure.

▲ Figure 25. Image loading screen.

◄ Figure 24: Move startup menu. Click on the 2d button to start the 2D Move application.
3. Now the cross section has been loaded, a database with the right horizons needs to be created:
   - Data ➜ Database
   - File ➜ New, in order to create a new database
   - Edit ➜ Insert ➜ Double click on a box to modify its content. (For example: double click on horizon_0, and type ‘Cupies’)
   - File ➜ Save as; save the database.
This database can be used for every cross section which will be opened. However, the database have to be loaded every time a new cross section file is made.

4. The next step is to draw the faults and horizons in the cross section:
   - Create objects toolbar ➜ click on the ‘’ button in order to draw faults. Click on the top of an existing fault in your cross section, followed by a click on the bottom. You can change its name in the Object List.
   - Create objects toolbar ➜ click on the ‘’ button to draw the different horizons. Choose ‘Horizons (Use Database)’, 2D move will now open the Horizon Name Selection. By clicking on one of the horizons which have been created in the database, you can start by tracing the horizon lines in the cross section.
   - Make sure to only draw one horizon line between different faults. Lines from the same horizon can be joined with the ‘Join’ button in the Tools Toolbar.

5. After these steps have been completed; structural modeling can be started:
   - Structural Modelling ➜ Move on Fault …., the Move on Fault window is opened.
   - Choose the method, collect the active fault and the objects to be moved (only objects in the hanging wall can be moved) and click on ‘Movement’.
   - Select ‘Join beds’, and choose the Footwall and Hanging wall, use a constant and strong formation, for example the top of the Tithonian, which is the Angèle horizon line.
   - Sedimentation, Erosion and Options are not necessary for this project.
   - Hit the ‘apply’ button, and check the results. If the formations are not continuous this it the time to modify it (hit the ‘undo’ button, make the modification, then again click on ‘apply’, etc...).
6. When the previous step has been completed successfully, the cross section can be unfolded:
   - Structural Modelling ➔ Unfold …, the Unfold window is opened. The Unfold option allows geological horizons to be restored to a pre-deformation condition.
   - The method to which is used is 'Flexural Slip'. Flexural Slip Unfolding uses a pin and a slip-system parallel to the template bed to control the unfolding of the beds. Unlike the line length unfolding algorithm, flexural slip unfolding maintains bed thickness variations.
   - A ‘pin’ must be used. It is important that this pin is drawn in the right place, this means that the pin should cross all layers, and that it is perpendicular to all of them. The ‘pin’ button can be used.
   - The formation lines are unfolded using the flexural-slip algorithm. In order to do this successfully a base-layer needs to be selected. In the Objects to be Unfolded window, both the base layer (the template objects) and all the other layers can be collected.
   - By clicking on the ‘Apply’ button, the cross-section will be unfolded.
   - Finally, to successfully unfold the rest, a line-length algorithm is applied to the segment. This algorithm is used to straighten beds while maintaining constant line length, however bed thickness variations are not maintained.

7. Check the final result for gaps or overlapping layers. If it does not look right, adjust it, and repeat the process. The goal is to balance all sections, and check them on correctness. After this has been done, the 3-dimensional modeling can start.
5.2 Results

5.2.1 Profile 1
Profile 1 was the first profile which was constructed. It runs from southwest to the northeast.

UTM coordinates + height/depth:
675946E 4931478N  +2425m
681041E 4933485N  -1800m
5.2.2 Profile 2
Profile 2 runs from southwest to the northeast. After the line length unfolding step had been performed, it is clearly visible that the layer does not have a uniform thickness. This feature will be discussed in subchapter 5.3.

UTM coordinates + height/depth:
675927E 4933989N +2650m
681041E 4936935N -1300m

▲ Figure 37. Original x-section.

▲ Figure 38. X-section after digitizing.

▲ Figure 39. Layers moved on fault.

▲ Figure 40. Flexural slip unfolded.

▲ Figure 41. Line length unfolded.
5.2.3 Profile 3
Profile 3 runs from south to the north,

UTM coordinates + height/depth:
680061E 4927976N +3125m
678993E 4937981N -1000m

Figure 42. Original cross section.

Figure 43: Digitized cross-section.

Figure 44: Layers moved on fault.

Figure 45. The cross section after Flexural slip unfoilding.

Figure 46. The cross section after Line length unfoilding.
5.2.4 Profile 4
Profile 4 runs from southwest to the northeast.

UTM coordinates + height/depth:
675934E  4927961N  +2475m
681055E  4930981N  -800m

The original cross section has undergone a major modification with respect to the rightmost fault. This will be discussed in subchapter 5.3.

▲ Figure 47. X-section after digitizing.
▲ Figure 48. Layers moved on fault.
▲ Figure 49. Flexural slip unfolded.
▲ Figure 50. Line length unfolded.
5.2.5 Profile 5
Cross section 5 runs from south-south-west to the north-north-east. The unfolding step did not go as it should, this is explained in the discussion, subchapter 5.3.

UTM coordinates + height/depth:
675853E 4930659N +2475m
677967E 4937977N -875m
5.2.6 Profile 6
Profile 6 runs from southwest to the northeast.

UTM coordinates + height/depth:
675929E  4932801N   +2400m
680988E  4935243N  -900m

▲ Figure 56. Original x-section.

▲ Figure 57. X-section after digitizing.

▲ Figure 58. Layers moved on fault.

▲ Figure 59. Flexural slip unfolded.

▲ Figure 60. Line length unfolded.
5.2.7 Profile 7
Cross section 5 runs from southwest to the northeast.

UTM coordinates + height/depth:
675906E 4929266N +1925m
680908E 4932175N -1300m

It can be noticed that the original cross section has undergone a major modification during the digitizing process, with respect to the rightmost fault. The orientation of the fault was not right. The flexural slip unfolding does also show an odd feature in the middle. Both matters will be discussed in subchapter 5.3.

▲ Figure 64. Flexural slip unfolded. Something strange happened, this will be discussed in subchapter 5.4.

▲ Figure 65. Line length unfolded.
5.2.8 Profile 8
Profile 8 stretches from west to the east.

UTM coordinates + height/depth:
675891E  4937931N    +2825m
681076E  4937922N    -775m
5.2.9 Profile 9
Cross section 5 runs from west to the east.

UTM coordinates + height/depth:
675851E 4928197N +2500m
680994E 4928197N -900m

▲ Figure 71. Original x-section.
▲ Figure 72. X-section after digitizing.
▲ Figure 73. Layers moved on fault.
▲ Figure 74. Flexural slip unfolded.
▲ Figure 75. Line length unfolded.
5.3 Discussion

In this subchapter, some of the divergent results which were obtained from the 2-dimensional modeling are discussed. As the research goal of this project was to find an construct viable, and physically possible, geological cross sections, sections 2, 4, 5 & 7 showed some deviant behavior.

5.3.1 Cross section 2:
During the unfolding process, it became clear that the cross section was not constructed properly. This could be noticed from curved lines in the section, figure 76 (indicated by the red circle). By going back to the original section, reconstructing the formation lines, the result shown in figure 77 was obtained.

After the line length unfolding step had been performed, it is clearly visible that multiple layers do not have a uniform thickness, figure 78. A shift can be noticed. This shift occurred due to the fact that the distance between the lines on the left side of the fault did not equal the distance on the right side of the fault, figure 79. After having modified this, the section can be unfolded properly, figure 77.

5.3.2 Cross section 4:
When the profiles were inserted into the digital elevation model, in order to check the consistency between the sections, it became clear that the right-most fault in profile 4 was not correct. The angle of the fault was too flat, compared to the topography and section 3. Therefore, it needed to be modified. This modification has only been applied to the digitized model, that’s why the original cross section still contains the old situation (figure 80).

5.3.3 Cross section 5
In cross section 5, the same event as in section 2 can be noticed. The lines are not continuous, a little shift is notable. After modifying this part in the original digitized section, a better result is achieved. It is important to take the whole section into account. Modifying something on the left of the section, can have influence on the right side and vice versa. Figures 81-84 display the problem + final result.
5.3.4 Cross section 7:
Looking at the topography and the other cross sections, the rightmost fault needed to be changed. Its orientation wasn’t correct. This is displayed in figure 85.

But this was not the only remark of section 7, after performing the flexural slip unfolding, an noticeable dip can be noticed in the middle of the section, figure 86. The profile however looks correct, it has probably something to do with a bug in the software. After checking the section, it was noticed that the horizons did not touch the fault. After having connected the lines to the fault, removing it on the fault, and unfolding the lines, the problem was solved.

5.3.5 Comparing the different profiles with the unfolded situations. Most notable is that profile 3 only has a 19% increase in length. Profile 5 does also little increase after flexural slip unfolding. This figures shows, combined with figure 14, that most compression has occurred during the East-West compression. (Profile 9 does also show little compression, this is due to the fact that this section is parallel with the Montagne d’Angèle.)
6. Three-Dimensional Modeling

In this chapter, the methods of creating a viable 3-dimensional model are presented. 3DMove Kinematic Modelling will be used in order to create this model, with the help of different workflows. Furthermore, this chapter will give some extra information about the background of the methods, the steps which need to be taken, and finally the results of the 3-dimensional modeling. In subchapter 6.4 the encountered problems and abnormalities will be discussed.

6.1 Background information

3DMove is Move’s 3D geoconstrained advanced structural modelling framework builder, structural restoration, validation and analysis component. This software is ideal for this project.

In chapter 5 the 2-dimensional cross sections have been constructed and checked for consistency. The first step in the 3-dimensional modeling process is to create the digital elevation model, DEM, and insert all cross sections into this model. An overview is created, and the first bigger structures become visible. Figure 88 shows the DEM + the corresponding cross sections. This figure might look complicated with the many horizon lines, but after the layers have been created, it becomes clearer. Then the faults + layers can be constructed. When this is done, the real modeling can start. The layers will be moved over the faults and finally be unfolded.

6.2 Step-by-step 3D Modeling

This subchapter will present all the different steps, to successfully perform 3-dimensional modeling on the area of interest.

6.2.1 Creating the basis.

1. First of all the digital elevation model needs to be created. There’s a document with all coordinates and corresponding elevation data available. This is an excel file with more than 172,000 values. If you know the UTM coordinates of the upper left corner of the area of interest, and the lower right corner of the area, all intermediate values are known.

- With this data, the excel file can be sorted, finally a file is created with only the coordinates + corresponding elevation of the area of interest, with around 20,500 unique coordinates + elevation. These values need to be converted in a .txt-file, this can be done by copying the values to note pad.

- The next step is to open 3DMove Kinematic Modelling. File ➔ Open, (by file format choose Ascii Data, figure 89), ➔ select the .txt-file. Next, the Ascii Import Options window is opened. Make sure to select meters and elevation for the XYZ-axis. Click; Next ➔ Load, and the digital elevation model is loaded (figure 90).
2. Insert maps into your digital elevation model.
   - This can be done by clicking on; File ➔ Insert.
     The GIS Data – Raster files format needs to be selected, since the maps are probably .jpeg files.
   - Select the map to be inserted, the ‘DEM Import: Image Name and Region’ window is opened (figure 91), and a preview of the map is given.
     Choose ‘Reference by defining horizontal extents’ ➔ next ➔ insert the top, bottom, left and right coordinates of the map, and load the file.
   - This map can be draped over the DEM by selecting DEM and choosing your overlay at the bottom of the screen.

3. The following step is to insert the cross sections.
   This is an easy step, since the cross sections contain all necessary information.
   - File ➔ Insert, choose the .MVE format.
   - Select the cross section, and click on ‘open’.
   With the Visible-option in the object list, objects can be made visible and/or invisible. Figure 92 gives an impression of the inserted cross sections combined with the DEM.

4. Since all information has been inserted into the file, the surfaces between the different cross sections can be constructed. This process is the same for creating both faults and layers.
   - In the main toolbar the ‘Model Building’-tab needs to be selected; various options become visible, select the Surface option. The 3D Surface Builder Tool is opened on the left side of the screen (figure 93).
   - In this case, we want to create surface between lines ➔ Build Surfaces From Lines.
   - Collect the lines which need to be connected by the surface, by holding the ctrl-button, multiple lines can be selected, and collected into the ‘Select lines’-section.
   - The best method to use in this case is the Spline Curves method.

Theory behind Spline Curves
A spline curve is a mathematical representation for which it is easy to build an interface that will allow a user to design and control the shape of complex curves and surfaces. The general approach is that the user enters a sequence of, in this case, lines, and a curve is constructed whose shape closely follows this sequence. The lines are called control lines. A curve that actually passes through each control line is called an interpolating curve; a curve that passes near to the control line but not necessarily through them is called an approximating curve.

Step 4. continues on the next page.
- To make the surface as accurate as possible, the ‘Sample Density’ and ‘Resample Lines’ should be put on the lowest value.

- By clicking on ‘Create Surface’ the surface is created between the selected lines/horizons. Figure 94 shows the DEM with the corresponding faults, whereas figure 95 contains the top of the Tithonian as well. If abnormalities are noted, extra lines can be created to solve these. It also helps to create new cross sections for sections which have a complicated structure. In this project a total of 9 cross sections have been created, together with some extra faults to ensure a proper model. However, not every section inside the area can be approached by lines. Therefore the option of creating points can also be applied.

- Choose in the Model Building-tab the ‘Point’ option. The Point Tool: 3D view is opened. When clicking on a certain position/spot in the 3D model with the left mouse button, a red dot appears. By clicking on the ‘Create Point’-button in the builder tool, the point will be created.

- Repeat this, until sufficient points have been created to construct a surface.

- Go back to the ‘3D Surface Builder Tool’ and choose ➔ Build Surface From Points.

- Collect the points which are needed to create the surface, and click on ‘Create Surface’.

- A surface will be created. When working with this tool; the more points, the more accurate the surface is. Figure 96 shows the Point Tool: 3D View builder.

The 3-dimensional model has been created. This model will serve as a basis for the 3-dimensional modeling process.

### 6.2.2 Moving on fault & Unfolding

These are the most challenging and important steps of the whole project. With different workflows we can perform these steps. The top of the Tithonian is the first layer to look at.

1. In the main toolbar ‘Workflows’ can be selected. Three options emerge in the Kinematic Modelling Module: Decompaction, Unfolding & Move On Fault.

   - Start by clicking on the ‘Move on Fault’-button. The Move On Fault builder is opened.

   - The method used is the ‘Fault Parallel Flow’. This can be selected in the drop-down menu. The following step is to collect the active fault, i.e. the fault where the layer needs to move on.

   - Collect the object, in this case, the layer to be moved.
The last input that has to be selected in the Movement window are the 'Join beds', this step is similar to step 5 in subchapter 5.1, collect the Footwall layer and the corresponding Hangingwall layer. Finally click on 'Apply'. These steps can to be performed for all separate layer segments. Figure 97 gives an impression of the result.

2. The final workflow is to unfold the layers.
- Click on the 'Unfolding'-button in the Workflows panel, the Unfolding window opens up, figure 98. There are two methods which can be used; the Simple Shear and the Flexural Slip. In this project the Flexural Slip method is used.

**Theory behind Flexural Slip unfolding**
The Flexural Slip method is an algorithm which allows unfolding that preserves volume between surfaces, bed thickness variations and the line length of the template beds in the unfolding direction. The pin plane used during flexural slip unfolding should be oriented parallel to the hinge line of the fold (Move Tutorial, 2012). The algorithm constructs a slip-system parallel to the template bed, which is used to control the unfolding of other beds in the fold.

- The next step is to insert information in the 'Unfold To…' menu. Choose Unfold to Datum
  - Select the datum at which the layers need to be unfolded. The top of the Tithonian can be chosen as the base, this means that the top of the Berriasian needs to have the value ‘125’ meters in this box.
- Like in subchapter 5.1, a pin has to be chosen as well.
- In the 'Objects to be Unfolded' window, the surfaces which need to be unfolded, have to be collected in the Template Beds window.
- Then finally click on 'Apply', and have patience, this process step might take a while.

3. We now have obtained the final result. If all data has been inserted properly, the three dimensional model should be unfolded right. Analysis can start on the unfolded model, the model might have missing parts, or overlapping parts. This will be discussed in subchapter 6.4.

**Figure 97**: Screenshot of the model after moving the top of the Tithonian on fault has been performed. The white arrow shows the movement plane.

**Figure 98**: The 'Unfold'-tool from the Kinematic Modelling Module.
A: Unfolding method; Flexural Slip
B: Unfold to Datum; choose a certain height.
C: The unfolding plane has to be chosen.
D: Similar to 2-dimensional unfolding, a pin is required.
E: Next step is to collect the objects to be unfolded, in this case the layers.
F: Pin plane.
6.3 Results
This subchapter contains the results of the creating the 3-dimensional model, the model after all layers have been moved on the different faults, and the unfolded model. The same colors as in figure 12 are used in the modeling process.

The moving on fault & unfolding processes have only been applied to the top of the Tithonian. Since this layer is the most accurate one.

6.3.1 3-Dimensional model
Figures 99 & 100 show a topview of the modeled area. Figure 99 also contains the actual map, this figure is a good indicator for where the top of the Tithonian reaches the surface. Figures 101 & 102 show the final result of the 3-dimensional model of the area of interest.

6.3.2 Model after moving on fault
The moving on fault step was a time consuming task. It took a lot of computer-memory, and some crashes of the computer to perform it. The first gaps appear in the model. Especially around the Montange d’Angèle moving became difficult. Figure 103 shows the result after moving on the different faults.
6.3.3 Model after unfolding

Figures 106 & 107 show 3D view of model after the top of the Tithonian has been unfolded. The increase in surface can be noted clearly, this is what was expected. The 3DMove Kinematic Modelling module also gives an 2D top view in a different window, this is given in figure 105.

<table>
<thead>
<tr>
<th>UTM Coordinates</th>
<th>Total distance (m)</th>
<th>Area (km²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Old (current situation)</td>
<td>675867 E</td>
<td>681080 E</td>
</tr>
<tr>
<td></td>
<td>4937982 N</td>
<td>4927965 N</td>
</tr>
<tr>
<td>New (original situation)</td>
<td>-673860 E</td>
<td>-681080 E</td>
</tr>
<tr>
<td></td>
<td>~4937930 N</td>
<td>~4928000 N</td>
</tr>
</tbody>
</table>

\[ Increase \text{ in area: } 19.5 \text{ km}^2 = +37.3\% \]

Figure 104, below, shows that there is an increase of 37.3% in surface, when the surface of the map and the surface of the unfolded model are compared.
The overlapping parts in the figures are not taken into account to calculate extra surface.

\[ \text{Figure 104. Table with old and new UTM Coordinates to show difference in surface.} \]

\[ \text{Figure 105. Unfolded model.} \]

\[ \text{Figure 106. 3D top view from the unfolded model.} \]

\[ \text{Figure 107. 3D top view from the unfolded model, with the DEM + map overlay.} \]
6.4 Discussion
During the different steps, a number of peculiarities can be observed. Several complications were encountered when constructing the 3-dimensional model out of the 2-dimensional sections. Especially around the Montange d’Angèle tricky situations appear.

6.4.1 3D Modeling
Like said above, some problems arose when constructing the three dimensional model. At some locations, the information given by the cross sections was not sufficient, especially in the southern part of the area of interest. Due to the curved faults, ‘points’ needed to be created around this section, since the software cannot create surfaces from one line. By creating the points; smooth surfaces, which do not cross the faults, were ensured.

Another problem was variation in distances between different horizons (figure 108 shows an example of this problem). The cross sections were created in the best way possible, but with the algorithms in the software, it can be possible that the thickness varies. This problem could be solved by creating points or extra cross sections. But since creating cross sections is a time consuming task (due to the extra balancing work), creating points is preferred, but this has to be applied with precision.

6.4.2 Moving on fault
The moving on fault step also gave, especially in the area mentioned above, some complications. The first gaps appeared in the model (figure 109), this is caused by the lack of information in this area. It is hard and useless to draw many more cross sections for these sections, since the problem of curved faults is not solved.
6.4.3 Unfolding

Finally the unfolding was performed. Some parts of the unfolded result are not satisfactory, and need some attention. Starting with the gaps which are present between the sections. These are caused by the faults. These gaps are not treated as serious problems, since it falls outside of the accuracy and scale of the project. Often, many corresponding surfaces on both sides of the faults, didn’t match up perfectly. This was also one of the problems in the moving on fault part. Therefore a small gap will always be visible. However bigger gaps, can also be noticed. These inaccuracies are probably caused by a lack of information of the surface and boundaries close to- and between faults. Looking at the 2D top view, the model looks like a jigsaw. By moving some parts by hand, the models starts to look more viable. This is shown in figures 110 and 111. In situation A, a possibility for the model is created by moving the section by hand in northeastern direction. The same is done for situation B and C.

![Figure 110. Moving some sections by hand, to create a better model.](image)

![Figure 111. Top view of the 3-dimensional model, with 3 modified sections. The modifications can be found in figure 109.](image)
7. Conclusion

The purpose of this report was to give a complete picture of the fieldwork, which was carried out last year. The main goal was to construct and balance a structurally valid 3D model of the fieldwork area in the French Subalpine Basin, and to understand its geology better. This chapter will give the main conclusions, new insights and the take home lessons.

After having worked for many weeks on a fieldwork project last year, I created in my eyes physically possible geological cross sections. But what you see does not have to be true. With this project I wanted to check if the cross sections were really possible. Looking at the results of chapter five, one can see that the sections are physically possible, after applying some modifications, but does this mean that they are also geological possible? No, in order to give an answer to this question a 3D model needed to be constructed out of it. Three dimensional models give you a much better look at the real situation.

Software
The first real problem which was encountered was the software to work with. Midland Valley had released a new version of Move this year; however there was not a real guidebook for my specific purposes. That's why one can find in chapter five and six two clear step-by-step guides for 2D- and 3D modeling of a fieldwork area. In order to save the time needed to understand the software for other students, who want to model their fieldwork areas as well.

Like said before, a three-dimensional model needed to be created in order to look at the viability of the whole project. Some problems were encountered during the layer modeling, the moving on fault step and the unfolding step. Especially in the layer modeling, the software was the real troublemaker. As good as the software is, it still does miss some features, such as creating layers between two parallel horizons, and a horizon running across the two.

In subchapter 6.4 it can also be seen that the unfolded section contains some gaps and overlapping sections, figure 105. These two issues are the main problems in the unfolded model of the top of the Tithonian. They represent inaccuracies in the three-dimensional model. Especially in the area close to the ‘Angèle-Grande Delmas strike slip’, the ‘Bouvières thrust fault’ and the ‘Montange d’Angèle’ (figure 17), an overlap and gap can be noticed.

However with the information available it is difficult to ‘repair’ this area in the model, since the area is surrounded by various faults. Layers sometimes tend to bend in an upward or downward manner at the edges of faults. The best way to solve these areas is to create the boundaries completely by hand in a trial-and-error process, which means that you need to create the layer, unfold it, analyze it, undo the unfolding, adjusting the layer, etc... This has not been done in the current 3D model, which therefore results in gaps and overlapping areas.

One can say that it is therefore not entirely accurate; however looking at the information available, the methods used and the geological history the model gives a quite accurate representation, which can be possible.

New insights
This report gives some new insights into the area of interest. Derived from several articles it was clear that the area had undergone two dominant phases of compression. The main structures modeled in the area have a NNE-SSW orientation, figure 17. After having performed the two- and three-dimensional modeling, it can be noticed that the area has been more compressed in the East-West direction, figure 87, than in the North-South direction.

During this report, it was also noticed that the geological map contained some errors. During the original fieldwork, parts of the map were drawn using a best guess, due to lack of information. However during this report several geological sections were constructed through these parts of the map. It became clear that some boundaries of formations were drawn to close to each other, and needed some modification. Since the vertical distances between different tops of formations should be constant, a certain horizontal distance on the surface is necessary, because you’re also dealing with a certain angle.
Figure 112 shows the lower left corner of the map. The top of the Barremian should be smaller, whereas the top of the Hauterivian and Valangian should definitely be broader. However you're still dealing with geology. Ask ten different geologists to assess the area, and you will get 10 different answers.

Take-home lessons
I have learned various things during this project. First of all it was an useful exercise to check and analyze the data which was derived during the fieldwork. It revealed inaccuracies which were overlooked first. The second thing that became clear is that you have never enough geological cross sections. More sections give a higher accuracy to the model, but since creating and analyzing these sections is a time consuming task, interpretations have to be made. Next time I, when more time is available, I would focus more on the most complicated areas, by drawing more sections.

Another thing is to be critical on the orientations of the formations at the surface, and combining this info with the geological map. This was not done properly during the fieldwork. Using the latest Move-software, was also challenging in the start. With no specific guide for our project it took some time to familiarize with some of the tools. But in the end I'm satisfied with the results derived with the software, and I think that being able to work with this software, can be very useful in the future.

Old & new interpretation
Comparing the geological history, chapter 2, with the three dimensional model, it is clear that two phases can be distinguished. A lot has happened in especially in the southern part of the area of interest. The first phase had a predominant North-South compression, which was caused by the first phase of the Alpine orogeny. During this phase of deformation the Iberian Peninsula rotated around the current southern part of France (figure 2). This compression resulted in folding in the area of interest, and created two anticlinal structures, one the northeastern part of the area, and one in the southeastern part, which is the Montange d’Angèle. This last one subsequently moved northward. Both structures have an East-West running fold axis. Most likely, a strike slip fault, which runs all the way from the south to the north in the area, crossed the area during this event. But this was not the only phase of compression, during the second phase of the Alpine orogeny, the Apulian plate (Italy) collided with the Eurasian (Europe), and created West-East compressions, with an average shortening of 36% (figure 87), which can be derived from the sections drawn in somewhat E-W direction. This is more than the shortening observed in sections 3 and 5, which have been drawn in the N-S direction. The dome and its corresponding fault in the northeastern part of the map can be explained by these two phases of compression. During the second phase the Couspeau thrust fault in the western part of the map probably has occurred. The total area has decreased with 28% during the phases of compression. Combining the surrounding areas with the area of interest would probably give an even better view of what influence the different phases have had on the French Subalpine Basin. But this falls outside the scope of this project.

Overall it can be concluded that with the resources available, a reasonably viable model has been created. The structures found in the model are consistent with the 2D data from the fieldwork and the literature. Comparing this information gives a reasonably valid representation of the real situation.
8. Afterword

Only by balancing a 3D model, the geology could be fully assessed. The resulting structurally valid 3D model, created from the 2D data, provides a basis for ongoing basin modeling and structural analysis. In a subsequent study one should look at the southern part of the area, and try to sift the different structures by creating extra cross sections, since this project was too short to do this. Another nice feature that could be implemented is to try importing the elevation model from Google Earth into Move, and using the satellite images from Google Earth more often.

References


Fossen, H., Structural Geology; Balancing and restoration, University of Bergen, Norway, 2010.


